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MODULE 2

USING THE COMPUTER AND MANAGING FILES

In this module, you will learn how to:

e Start the computer;

e Perform actions in the operating system environment;
e Change the settings of the user environment;

e Retrieve basic information about the computer;

e  Print documents;

o Work with files in the operating system environment;
e  Work with folders;

e Use the built-in help functions of the system.

Using the Computer System

Virtually any kind of job on a computer entails these steps:
e Starting the computer system;
e Opening an application;
e Working on a document (file) in the application;
e Saving the work;
e Turning off the computer system.

Let’s look at these tasks in more detail.

Starting the Computer

The basic components of a computer system are usually the system unit and monitor.
There may be additional devices connected, such as a printer or scanner. Modern
computers also often have multimedia devices connected, such as a webcam, audio
system, or microphone. It is also necessary to have devices for input of information and
commands — the keyboard and mouse. The different components are connected with
cables and receive power directly from a wall socket, or from a UPS (Uninterruptible
Power Supply) unit, which is used to provide power to the computer system in the event
of a mains failure. Portable computers combine the monitor and system unit in a single
case.

Note!

Cables may be connected, switched or disconnected only when the computer system is
turned off and disconnected from the mains.

An exception — Universal Serial Bus (USB flash memory and devices) and network
connections.
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To start the computer system:

1. Press the on/off button on the system unit. It is typically found in the front of
the system unit, and is easy to locate;

2. Turn on the monitor if it does not turn on automatically (if it has been previously
turned off with the on/off button);

3. Wait while the operating system boots.

A computer system starts in a specific sequence. The power supply of the system unit
turns on first. Normal operation is indicated by indicator lights on the computer’s system
unit. The BIOS (Basic Input/Output System) software launches next, starting the
computer — testing the random-access memory, activating the components of the
computer system, as well as the video card, which turns on the monitor if it is in standby
mode. The BIOS does not have to be installed, as it is already stored in the computer’s
permanent memory. There may be an audio signal during this stage — a single beep,
indicating normal operation of the system.

Next, the operating system is located. The BIOS searches the computer’s disk drives and
connections in a specific sequence until the operating system is found.

Note!

If the operating system does not start, there may be a floppy disk left in the computer.

An operating system is a type of software that normally launches when the computer is
started, and provides a graphical environment (interface) understood by the user.
The operating system allows controlling the computer’s hardware and devices, and
ensures that the different components of the computer system work together.
Some examples of popular operating systems:

e Windows (various versions);

e Linux (various versions);

e Mac OS —the operating system of Apple computers.

Task 2.1. What does it mean if the following message appears on the computer
display: DISK BOOT FAILURE, INSERT SYSTEM DISK AND PRESS ENTER?

Choices:

The computer does not have an operating system installed;
A music disc has been left in the computer;

Failure or lack of a hard disk drive;

The computer was turned off incorrectly;

A USB flash drive is connected to the computer;

All of the above.

o v hs wWwN R

Logging In to the Operating System
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Successful activation of the operating system is indicated by a graphical image on the
display. It may differ for various operating systems. Linux operating systems offer
several visually different graphical environments (interfaces).

This material examines the operating system Linux Ubuntu (version 10.10) with the
default graphical environment Gnome.

The folder 2_computer_files with task templates must be copied to the Documents
folder on the user account.

A password can be used to protect user data. If a computer is used by several users, it is
convenient to create several independent work environments — user accounts.

User accounts in computer systems are used:

e To create an individual work environment for each user: the desktop, folders for
saving files, language settings, workspace customisation without affecting other
users of the same computer;

e To authorise specific actions in the operating system and set permissions of
accessing the computer or network resources.

Web services also commonly have user accounts to ensure secure access to the
resource. For example, an e-mail user has access only to their own inbox.

A special account is the administrator. This user has the widest permissions on the
computer system; it can add and remove programmes, create other user accounts, set
the permissions of other users, select resources to be shared, and change important
system settings, such as date & time.

A user account may also be created to access a computer on a network.

In these cases, it is necessary to select (or enter) your username and enter the
password — verify your rights and permissions to the operating system.

To log in to your user account in the Linux Ubuntu operating system:

1. Click on your username;
2. Enter the password;
3. Click Log In:

®

Ubuntu 10.10

Dace

Password: | -------- |

Cancel || Lng In |
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After logging in, the graphical environment of the user account opens. By default, Linux
Ubuntu uses the Gnome environment.

A B C E F G
L P | | |

B MonFeb 28, 1:28AM @ dace

'C:lAppli(ations Places! system @& " Ly «) 1y

sb
PENDRIVE

Image 1. Graphical environment Gnome

e Applications menu —A;

¢ Places, selection of locations in the file structure — B;

e System tools menu—C;

e Top Edge panel — D. Usually contains navigation menus, the keyboard switcher,
current time, operating system shut down button, e-mail client button;

e Keyboard layout switcher — E. May not be visible if additional keyboard
languages have not been specified during the installation of the operating
system;

e E — various system notifications — time & date, e-mail messages received, user
account name;

¢ Shut Down menu - G;

e Bottom Edge panel — H. Displays a button for each open window;

e Trash-—1;

e Workspace switcher buttons — J. The Linux environment offers 4 workspaces by
default. Although a single workspace is usually sufficient, if it is necessary to
work with multiple applications at the same time, they can be placed in different
workspaces. The workspace is switched by left-clicking the corresponding
button:
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Current workspace: "Workspace 1"

Note:

The terms default and by default refer to the initial state where the user has not made
any changes to the settings of the operating system or an application.

For example, by default there are no icons on the desktop, but icons can be placed on
the desktop by the user.

Opening an Application

The operating system ensures the overall operation of the computer system and its
components, and provides the graphical user interface.

Specific tasks, in turn, are performed in applications. Applications are used, for example,
to create text documents, browse the web, or use multimedia. Applications use the
operating system as a unified platform to ensure their operation and communication
with devices such as a printer.

Lists of the applications available on the computer system are typically arranged in
menus. In the Gnome graphical environment, the application menu is positioned in the
panel at the top of the display (workspace). As there are usually many applications on a
computer, they are grouped by type or task.

Applications are opened:
e By finding the necessary programme in the list of applications and clicking on its
name — to create a new document.
e By double left clicking on the icon of an existing document.

Let us examine the activation of the application gedit. Gedit is a simple text editor, and
is included with the Linux Ubuntu operating system by default.

To activate the application:

1. Click the Applications button in the upper left corner of the desktop;
2. Move the mouse pointer to the Accessories group;
3. Inthe menu, click on the application name Text Editor:
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t) Applications | Places System e«
" Accessories 0 @ calculator

EE Games » Character Map

‘ﬁ Graphics + D Disk Usage Analyzer
O Internet » (= Manage Print Jobs
il Office » Q_ search for Files...
& sound & video » [J] Take Screenshot

Ubuntu Software Center [ Terminal

7 Tomboy Notes BT

This sequence of actions is written as follows:

Applications—>Accessories—>Text Editor

Application Window

Within the graphical environment of the operating system, each application opens in a
separate window. The window system has become standard; it is intuitive and easy to

use. The windows of different applications are similar in design and structure, and
contain similar elements.

r

@ - 0 *uUntitled Document 1 - gedit —A

[File Edit View Search Tools Documents Help] B

& [aOpen ~ E"Save = @ Undo ﬁ Q % ]7C
*Untitled Document 1 D
What is Lorem Ipsum?

Lorem Ipsum is simply dummy text of the printing and typesetting industry.

Lorem Ipsum has been the industry's standard dummy text ever since the

1508s, when an unknown printer took a galley of type and scrambled it to

make a type specimen book. It has survived not only five centuries, but also—E
the leap into electronic typesetting, remaining essentially unchanged. It

was popularised in the 1968s with the release of Letraset sheets containing

Lorem Ipsum passages, and more recently with desktop publishing software —F
like Aldus PageMaker including versions of Lorem Ipsum.

Where does it come from?

Contrary to popular belief, Lorem Ipsum is not simply random text. It has
roots in a piece of classical Latin literature from 45 BC, making it over
2080 years old. Richard McClintock, a Latin professor at Hampden-Sydney
College in Virginia, looked up one of the more obscure Latin words,
consectetur, from a Lorem Ipsum passage, and going through the cites of the
word in classical literature, discovered the undoubtable source. Lorem Ipsum
comes from sections 1.10.32 and 1.10.33 of "de Finibus Bonorum et

Malorum" (The Extremes of Good and Evil) by Cicero, written in 45 BC. This
book is a treatise on the theory of ethics, very popular during the

Pmmmd ;e mm  Them £l mmmde N Zmm mk | omrmmme Tm mname MA mommmn Zmmname T mem mdde  memmde n

PlainText v | Tab width: 8 + Ln9, Col296 INS —QG
Image 2. Elements of the gedit window:

e Title bar (A in Image 1) — shows the name of the open document and the
application. The window control buttons are also normally located in the title
bar.

e Menu bar (B in Image 1) — contains menus for various commands in the
application or window. The menu names indicate the function of the respective
group of commands, e.g.: File — commands that apply to the entire document;
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Edit — editing commands, such as copy, paste, find & replace; View — add or
remove components of the application’s user interface.

e Toolbar (Cin Image 1) —toolbars contain frequently used commands in the form
of graphical buttons. The name of the respective function appears upon
hovering the mouse pointer over the button. The application gedit has a single
toolbar, but there may also be several of them. Toolbars can be added and
removed as desired through the View—>Toolbars menu.

e Tab (D inImage 1) — it is possible to work with several open documents in gedit.
Tabs are used to switch between them. They are also often used to group
settings and options in dialogue boxes.

e Workspace (E in Image 1) — the open document in the application. The area for
its creation and editing.

e Scrollbar (F in Image 1) — auxiliary bar for cases where the entire document does
not fit inside its window. Widely used in menus, as well.

e Status bar (G in Image 1) — typically located at the bottom of the window.
Displays information about the document — number of characters, lines, tab
data. The information shown in different applications varies.

Saving

Upon saving a work, the application creates a file of a specific type and saves it in the
permanent memory — on the computer’s hard disk drive (HDD). The default file type is
determined by the application used; the user may also save the file in a different format
if the application allows it. The operating system assigns each file type a small,
recognisable graphical image (icon), which represents the file within the computer’s
graphical interface.

Note!

The appearance of file icons depends on the operating system settings and the
programmes on the computer.

In addition to the name, a file is also given an extension, which essentially indicates the
file type and association with an application. The extension is separated from the
filename with a dot.

H—-

lorem_ipsum.ods

|

A B

A — name; B — extension; C —icon

Image 3. Representation of a file

Commonly used file type icons in Linux Ubuntu (default settings):

File type Icon Application
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Text = Any text editor

Lorem

lorem_ipsum.txt

Text What Without a filename extension, any text

o editor

lorem_ipsum

Rich text Text editors, opens in OpenOffice.org
document L Writer by default

lorem_ipsum.rtf

Text document

L

lorem_ipsum.odt

OpenOffice.org Writer

Database

—
—
g

lorem_ipsum.odb

OpenOffice.org Base

Presentation

—_—
=
@ =

lorem_ipsum.odp

OpenOffice.org Impress

Spreadsheet E OpenOffice.org Calc
workbook
lorem_ipsum.ods
Spreadsheet X Microsoft Office Excel 2007-2010,
workbook 2 opens in OpenOffice.org Calc

Partyplanner1.xlsx

Text document

W,

teksts.docx

Microsoft Office Word 2007-2010,
opens in OpenOffice.org Writer

PDF

lorem_ipsum.pdf

Adobe Acrobat Reader

Web page

<lxml
=L

PR
<html

Untitled 1.html

Web browser, e.g., Mozilla Firefox,
Google Chrome

Picture in JPG,
JPEG format

NTy

Folders.jpg

Picture editing and
applications, e.g., GNU Paint, GIMP

managing

Picture in BMP
format

Ty

Folders.bmp

Picture editing and managing

applications
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Picture in TIFF F r Picture editing and managing
format It rl applications
Folders.Liff
Picture in PNG - r Picture editing and managing
format lt wi applications
Folders.png
Audio in MP3 Multimedia applications, opens in
format mp3 Totem Movie Player by default
my_song.mp3
Video in MPG H Multimedia applications, opens in
format Totem Movie Player by default
my_movie.MPG
Video in AVI Multimedia applications, opens in
format Totem Movie Player by default

my_movie.avi

Adobe Flash video
for web pages

<

for_web.flv

Adobe Flash Plugin — a web browser
plugin, opens in a web browser or
multimedia application

Adobe Flash video
for web pages

f

files_and_folders.
swf

Adobe Flash Plugin — a web browser
plugin, opens in a web browser or
multimedia application

RAR compressed
file

lrar_|
extract_me.rar

Compressed file management
programmes, file and disk management
programmes, opens in File Roller by

default

ZIP compressed
file

| Zip |

extract_me.zip

Compressed file management
programmes, file and disk management
programmes, opens in File Roller by

default

Temporary file in
Linux operating
system

Dace

~lock.albums.ods#

Hidden by default, not Vvisible.
Temporary files are created by
programmes for their operation, and are
later removed.

Temporary file in
Windows
operating system

101

~WRDO0000.Emp

Windows operating system
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Windows <> Windows operating system
executable file

run_me.exe
Windows system <> Windows operating system
file

BENCH.DLL

To save a file in the application’s default format:

1. Perform the menu command File->Save;
or
2. Click Save in the toolbar:

i Save h‘;‘f

5o the current i

3. Enter the file name in the Name field of the Save As dialogue box;
Confirm by clicking Save:

#® Save As...

Name: Ilorem_ipsum\ ]

¥ Browse for other folders

4 | it dace Create Folder
Places Name v Size Modified

Q search @l Desktop 20:42
& Recently Used [ Documents 21:19
4l dace (£ Downloads 20:58
Bl Desktop 4l Music 12/10/2010
1 File system =] Pictures 20:30

= 000 0n 10.0.0.60 [ Public 12/10/2010 !
| PENDRIVE @ Templates 12/10/2010| | !
i Documents IE videos 12/10/2010

i Music . examples.desktop 179 bytes 12/10/2010 |
@ Pictures | | lorem_ipsum 1.6 KB 19:32 f
Il videos

i Downloads

AllFiles v

Character Encoding: | Current Locale (UTF-8) = | Line Ending: | Unix/Linux v

Cancel | | sameE |

Task 2.2. Create a plain text document in gedit

1. Start the computer, if it is not already on;
2. Open the application gedit
2.1.Perform the command Applications->Accessories—>Text Editor in the top panel
menu.
3. Entertext in the document:
3.1.Using the keyboard, enter This is my first line.
4. Save the file with the name plain_text:
4.1.Click Save in the toolbar.
5. Close the application:
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5.1.Perform the command File->Quit.

Shutting Down the Computer System

Hundreds of operations may be taking place in the computer system at any one time.
When the user clicks a button, and software translates this seemingly simple command
into a language understood by computer hardware and devices, it starts an entire
sequence of processes connected with the execution of the command.

Most operations of the operating system and applications are not seen by users — they
occur in the background. Therefore it is impossible to tell just by looking whether a
process in the system is still ongoing or if all operations have been completed.

By terminating unfinished hidden operations of the operating system, the result can be
unpredictable — it is possible to lose files, damage software or devices.

The computer system must be shut down in a specific sequence. Essentially, the
operating system winds down first, and turns off the system unit at the end.
To shut down the computer system:

Save any current works;
Close all open applications and windows;
Click the button in the upper right corner of the desktop;

S

Select the command Shut Down:
Wed Feb 23, 10:59PM @ dace (O | 1

H Lock Screen

Guest Session
Switch From dace...

2 Carl
Log Out...
Suspend
Hibernate
Restart...
| shut Down... N
(3

5. Make sure that the computer system shuts down;
6. Turn off the monitor, if necessary.

Other commands available:

e Restart — turns the computer off and on again. Used after installation of
programmes, if an application becomes unresponsive.

e Lock Screen — locks the desktop and requires a password to be entered to
continue work. Used to prevent unauthorised access while the computer is left
unattended. To use this option, the user account must be protected with a
password.

e Log Out - to log out from a user account without shutting down the computer.
The next user will not have to start the computer again.
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e Hibernate — a special mode for preserving the status of all current works and
open applications. When the computer is started again, the workspace is the
same as before entering the hibernation mode.

e Suspend — standby mode. The computer is not turned off, but switches to a low
electricity consumption mode. The monitor turns off.

e Guest Session — opens a temporary user environment. Used for brief tasks
without terminating the existing user’s session.

e Switch from ... — switch to a different user’s work environment, if several user
accounts have been created on the computer.

Task 2.3. Shut down the computer by using the hibernation mode

1. Open a web browser:
1.1.Perform the top panel menu command Applications->Internet->Firefox Web
Browser;
2. Open gedit:
2.1.Perform the command Applications->Accessories—>Text Editor;
3. Enter the word Sun in the document. Do not close the application.
Open the game Mines:
4.1.Perform the command Applications->Games->Mines;
5. Shut down the computer by using the hibernation mode:
5.1. Left-click the shut down button in the top panel;
5.2.In the menu, execute the Hibernate command with a left click:
Tue Mar 22, 8:18PM @ dace (O 13
Lock Screen tri+Alc+
Guest Session

Switch From dace...
2 carl

Log Out...
Suspend
\ LAt b b %_l
Restart to Complete Update...
Shut Down...

5.3. Wait until the computer system fully shuts down.
Start the computer;

Log in to the system, if necessary;

Check if the previously opened applications are still active;

© o N o

Close the applications:
9.1.In the title bar of Games, left-click the Close button:

’b_ O Mines

9.2.Repeat this step for the applications gedit and Mozilla Firefox.

Managing the User Environment

The workspace is what the user sees every day when working with the computer.
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Linux Ubuntu has four workspaces by default. The changes examined in this tutorial
apply to all four workspaces at the same time.

Changing Workspace Settings

Sooner or later, the user gets tired of always looking at the same workspace; there may
also be other reasons to change the appearance, such as wishing to use a pet’s photo as
the desktop background, changing the font size and display resolution.

Sets of appearance settings are often combined in themes.

Frequently customised elements are:
e Workspace design and appearance;
e Desktop background;
e Workspace font size;
e Display resolution;
e Screensaver and its settings.

To change the workspace and window design theme:

1. Perform the menu command System->Preferences—>Appearance;
2. Choose a design theme in the Appearance Preferences dialogue box;

-

Theme | Background | Fonts | Visual Effects

Ambiance Clearlooks

S
[ Customize... l | install.. |
Get more themes online
| Help | | Close ! |

3. Close the dialogue box by clicking Close.

Useful tip:

The design of the selected theme can be modified in the Customize Theme dialogue
box, which is opened by clicking Customize:
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Lide Customize Theme

Controls | Colors | window Border | Icons | Pointer

Open & @® Ambiance

open| ¥ ® MEEEGT]E

open| ¥ @ ClearlooksClassic
¥ ® Crux
|Open| & © Dust

Open| E4 © DustSand

[ZJCN HighContrastinverse

To change the desktop background:

1. Perform the menu command System->Preferences->Appearance;
2. Open the Background tab;

—
& Appearance Preferences

Theme | Background | Fonts | Visual Effects

Aeg

JPEG image, 2000 pixels by 1331 pixels
Folder: /usr/share/backgrounds

Style: |Zoom ~ Colors: | Solid color
Get more backgrounds online Remove Add...
Help Close

3. Select a picture by clicking on its preview;
4. Close the dialogue box by clicking Close.
To change the type and size of system fonts:

1. Perform the menu command System->Preferences—>Appearance;
2. Open the Fonts tab;
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& Appearance Preferences

Application font:
Document font:
Desktop font:
window title fonk:

Fixed width font:

Rendering

(") Monochrome

Theme | Background ||Fonts|| Visual Effects

Ubuntu 11

Sans 10
Ubuntu 11
Ubuntu Bold 11
Monospace 10

() Bestshapes

abcfgop AO abcfgop

abcfgop AO abcfgop

() Best contrast

@® Subpixel smoothing (LCDs)

abcfgop AO abcfgop

abcfgop AO abcfgop

3. Select fonts:

Help |

Details...

| Close |

3.1. Application font — used in menus, toolbars, dialogue boxes;

3.2.Document font — used in documents by default;
3.3.Desktop font — used in icon titles on the desktop;
3.4.Window title font — used in window title bars for the name of the document

and application.

4. Close the dialogue box by clicking Close.

The resolution determines the visual size of icons, text and other objects. The operating
system will most likely be able to automatically determine the type and resolution of the
monitor connected to the computer system. However, there are cases, for example,
when using a projector, when the resolution set by the system has to be changed.

To change the size of workplace objects on the display:

Perform the menu command System->Preferences->Monitors;
Choose the desired resolution in the Resolution menu of the Monitor Preferences

dialogue box;

-
# Monitor Preferences

| Detect monitors |

Panel icon
| show monitors in panel

| Make Default | |

Monitor: Unknown

Resolution: | 1152x864(4:3) ~ )

Refreshrate: |60Hz

v
J

Rotation: | Normal

v
J

Apply | Close
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3. Close the dialogue box by clicking Close.

Useful tip:

To ensure optimum image sharpness and contrast on an LCD monitor, use the
manufacturer’s recommended resolution for the respective model. It can be found in
the user manual of the monitor.

Screensaver

Screensavers were initially developed for computers with CRT (vacuum tube) monitors
in order to extend their life. Computer systems originally did not have a changing
graphical environment; the same image was displayed in the monitor for a long time,
which eventually lead to burn-in. Screensavers today have a function of design,
entertainment, and security.

If there is no user input for a specific period, the screensaver turns on, dims the screen
or displays a different static or dynamic image. To return to work, the user only has to
move the mouse or press any key on the keyboard.

Along with using a screensaver, it is also possible to set the monitor to turn off after a
specific period without user input.

To set a screensaver:

1. Perform the menu command System->Preferences—>Screensaver;
2. Choose a screensaver in the Screensaver Preferences dialogue box (A in Image 4);

r

% Screensaver Preferences

Screensaver theme:

Blank screen
Random

AntSpotlight
Cosmos

A—
Floating Feet {}
Floating Ubuntu
FuzzyFlakes
GLBlur
GLCells
GLMakrix

B — Preview

1 hour

Regard the computer as idle after:

C—& Activate screensaver when computer is idle

D—& Lock screen when screensaver is active

Help Power Management Close
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Image 4. Setting a screensaver

3. If necessary, preview the screensaver (B in Image 4);
4. Select optional settings:
4.1. Activate the screensaver — C in Image 4;
4.2.Tick the checkbox to lock the screen when the screensaver is active (D in
Image 4). In this case, it will be necessary to enter the user account password to
stop the screensaver;
4.3.Adjust the time of inactivity after which the screensaver is activated — F in
Image 4;
5. Close the dialogue box by clicking Close.

To change the monitor’s power settings:

In the Screensaver Preferences dialogue box, click Power Management;
Choose the settings:
3. In the tab On AC Power, use the Display menu to set the time of inactivity after
which the computer is turned off:
Display

Put display to sleep when inactive For: 0:15 v

Keyboard Layouts
Many languages use letters that are not part of the standard Latin alphabet.

In order to enter such characters, a dead key is set, which provides additional
functionality. The dead key is struck and released before pressing the main key. If a
suitable keyboard layout has been chosen, this results in entering a letter with a diacritic
of the respective language.

For example, in Latvian there are letters with a macron or a cedilla. To enter them, a
dead key is used — typically the apostrophe key on the keyboard (‘):

=l
LA
Ll
La]]
"
—
=i
=

There are also alphabets not based on Latin at all, such as the Cyrillic or Arabian
alphabets.

For these cases, it is possible to add additional keyboard layouts.

Note!

The interface language of the operating system and applications is not changed by
changing the keyboard language and layout.

To add a keyboard layout:
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1. Perform the menu command System->Preferences->Keyboard;
In the Keyboard Preferences dialogue box, open the Layouts tab;
Click Add:

% Keyboard Preferences
General | Layouts | Accessibility | Mouse Keys | Typing Break

Latvia Tilde (~) variant

Add...

 Select a keyboard layout to be added to the list

& Separate layout For each window

& Newwindows use active window's layout
Keyboard model: Generic 105-key (Intl) PC

Options... Reset to Defaults Apply System-Wide...

Type to test settings:

Help Close |

4. Select a country in the Country menu under the By country tab of the Choose a
Layout dialogue box:
5. Inthe Variants menu, choose the layout type:

% Choose a Layout

By country | By language

Country: | United States v

Variants: | USA Alternative international (Former us_intl) +

6. Make sure that the choice is correct by using Preview;
7. Click Add;
8. In the Keyboard Preferences dialogue box, arrange the keyboard layouts in the
desired order:
8.1.Select a layout;
8.2.Use the buttons Move Up and Move Down to order the chose layout in the list.
9. Inthe field Type to test settings, test the chosen layout by entering any text;
10. Close the Keyboard Preferences dialogue box by clicking Close.
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-
® Keyboard Preferences

General | Layouts | Accessibility | Mouse Keys | Typing Break

Latvia Tilde (~) variant

USA Alternative international (Former us_intl)

Germany

Add... Move Up

Remove Move Down Move the selected keyboard layout up in the list

& Separate layout for each window

& Newwindows use active window's layout

Keyboard model: Generic 105-key (Intl) PC
| Options... Reset to Defaults Apply System-Wide...
Type to test settings: ( abcdefgh )
|

Useful tip:
The default keyboard layout is at the top of the list.

When working in applications, the necessary keyboard layout is selected in the top bar
of the desktop:

) E¥ ThuFeb24, 1:02PM @ dace
Latvia Tilde (~) variant
» USA Alternative interna
Germany

Bnal (Former usintl)

Keyboard Preferences
Show Current Layout

Date & Time

The computer system has a time mechanism built in, a kind of clock intended not only
for user convenience. Many system processes use the time & date of the computer’s
clock. Correct time settings are particularly important for systems connected to a
network, or when working with databases and registration systems. In many
applications it is possible to insert a time & date field in a specific format.

The time setting on the computer can be synchronised with a special network and web

server time service.

Note!

Changing the time & date settings requires administrator permissions.

To change system time & date settings:
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1. Perform the menu command System->Administration->Time and Date;

In the Time and Date Settings dialogue box, click the button Click to make changes:

¥ Time and Date Settings
Time zone:

Configuration:

Time:
Date:
Sun Mon Tue Wed Thu Fri Sat
24
Help lick to make changes Close
>
A —
__ Authentication is needed to make changes. [EESSS

3. Enter the system administrator password;
Click the Authenticate button;
5. Make the desired changes:

% Time and Date Settings

Time zone: [ Europe/Riga ]— B
Configuration: [ Manual v ]—C
A—[ Time: |13 2| |27 s |29 :] &—
Date: KFebruar:\,r » 42011
sun Mon Tue Wed Thu Fri Sat
1 2 3 4 5
6 7 8 9 10 11 12 —E
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28
Help REF Click ko prevent changes Close

A —time setting (hours, minutes, seconds); B — choose time zone; C — choose type of synchronisation
(manual or automatic); D — apply changes; E — set date

Image 5. Changing time and date settings

6. Apply the changes by clicking the Synchronize Now button (D in Image 5);
7. Close the dialogue box by clicking Close.

Task 2.4. Apply changes to your user account
1. Apply the theme Clearlooks:

1.1.Perform the top panel menu command System—->Preferences—>Appearance;

1.2.In the Appearance Preferences dialogue box, click on the Theme tab, if

necessary;
1.3. Left-click on the appearance theme Clearlooks.
2. Change the desktop background picture:
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5.

2.1.In the Appearance Preferences dialogue box, click on the Background tab;
2.2.Click on one of the background pictures.

Set font size 10 for the desktop font Ubuntu;

3.1.Click on the Fonts tab;

3.2.Click the Desktop Font button:

Desktop font: N Ubunktu 11
Ry

3.3.In the Size pane of the Pick a Font dialogue box, select font size 10;
3.4.Close the dialogue box by clicking OK:

.

s Pick a Font
Family: Style: Size:
TlwgTypewriter [~] ~

. bk I

Tlwg Typist Italic A

Tlwg Typo Bold 9
e Bold Italic = H

Umpush H 11b

UnBatang 12

UnDoktum (~] I [13
(T 2] ~ Ll
Preview:

abcdefghijk ABCDEFGHIJK

| Cancel | | 0K |

3.5.Close the Appearance Preferences dialogue box by clicking Close.
Set a screensaver:
4.1.Perform the menu command System->Preferences—->Screensaver;
4.2.In the Screensaver theme pane of the dialogue box, choose the
screensaver Fiberlamp:
4.3.Set the computer to be regarded as idle after 20 minutes:
4.3.1.Click on the slider Regard the computer as idle after;
4.3.2.While holding the left mouse button, drag horizontally to set 20 minutes.
4.4.Make sure that the checkbox Activate screensaver when computer is idle is
ticked;
4.5.Set the user password to be required in order to start working again:
4.5.1.Tick the checkbox Lock screen when screensaver is active by left-clicking
on it.
4.6.Close the Screensaver Preferences dialogue box by clicking Close.
Add the keyboard layout Latvia Apostrophe ( ‘) variant:
5.1.Perform the menu command System->Preferences—>Keyboard;
5.2.In the Keyboard Preferences dialogue box, open the Layouts tab by clicking on
it;
5.3.Click Add;
5.4.In the Choose a Layout dialogue box, select Latvia in the Country menu;
5.5.In the Variants menu, select Latvia Apostrophe (‘) variant:

By country | By language

Country: | Lakvia

<>

Variants: [Lat\.ria Apostrophe (") variant

L
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5.6. Confirm the choice by clicking Add in the dialogue box.
6. Setthe added keyboard layout as the default:
6.1.In the list of languages, click on the added layout Latvia Apostrophe (‘) variant;
6.2.Click Move Up to move the layout to the top of the list;
6.3.Click Close to close the dialogue box.
7. Make sure that the system time & date and time zone in the top panel are correct;
8. Set 24-hour time format:
8.1.Right-click on the time area in the top panel of the workspace;
8.2.In the right-click menu, choose Preferences;

@}y [ sunFeb27,10:05AM
CopyTime
Copy Date
| N
Help "
About

Remove From Panel

[¥I Lock To Panel
8.3.In the Clock Preferences dialogue box, choose 24 hour format;
® Clock Preferences

General | Locations | Weather

Clock Format

© 12 hour format @ |24 hour Format

"2
[

Panel Display
Show the date
[] show seconds
Show weather

Show temperature

Help Time Settings Close

9. Click Close.

Working with Several Windows

It is possible to work with several applications (documents) at the same time in the
operating system environment. The previous application does not have to be closed to
open another one. Each application opens in a separate window; each window has
separate control buttons with the name of the window. Each open window has a
corresponding button in the bottom panel of the workspace. If there are many
applications open, the size of the buttons decreases, and the name of the application
(document) is visible only partially.

Useful tip:

Hovering the mouse pointer over an open window in the taskbar displays the full name
of the window as a tooltip:

‘m [Upda... [& faili vi... '@ Ubunt... | & Mines # Untitle... B ScregufaidytEl=g == y=)e=

The currently-active window is first in the window sequence, and its title bar has a
different colour or shading:
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[sample answerfile 2.... |5 Untitled 1- OpenOffic...

To switch between the open windows:

Click on the button of the desired window in the taskbar.

To close, maximize, minimize a window:

Use the window control buttons in the title bar:
r
@ - O

A BC

A — Close: closes the document (application); B — Minimize: minimises the window without closing the
application; C — Maximize: maximises the window to the maximum workspace size/restores the previous
size

Image 6. Window control

A minimised window is restored by clicking the window’s button in the taskbar.

A maximised window is restored to the former size with the Restore button, which
replaces the Maximize button.

To resize a window:

1. Position the mouse pointer on the window’s border for vertical and horizontal
resizing;

2. When the appearance of the mouse pointer changes, click the left mouse
button:

=l

3. Dragin the necessary direction while holding the button;
4. When the desired size has been reached, release the button.

To resize horizontally and vertically at the same time, use the corners of the window:

INS ]

To move a window:

1. Click on the window’s title bar;
T

dit (7
Jcuments

2. Dragthe window while holding the left mouse button;
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3. When the desired position is reached, release the mouse button.

Note!

A window cannot be resized or moved when it is maximised.

Task 2.5. Manage application windows

1. Open the following windows:
1.1. Web browser: Applications->Internet->Firefox Web Browser;
1.2.The application gedit: Applications—>Accessories—>Text Editor;
1.3. Calculator: Applications—>Accessories—> Calculator;
1.4.Documents folder: Places—>Documents.
2. Inthe Calculator application, solve the equation2 +2 =7?:
2.1.Switch to the Calculator window by clicking the button in the bottom panel:

# Untitled Docu...( |g Calculator 7 Documents i

2.2.Solve the equation.
3. Maximize the window of the Documents folder:
3.1.Use the window control button Maximize.
4. Increase the size of the gedit window:
4.1.Switch to the gedit window by clicking the button in the bottom panel;
4.2.Position the mouse pointer in the bottom right corner of the application
window;
4.3.Click the left mouse key;
4.4.While holding the button, drag right;
4.5.Release the mouse button.
5. Close the gedit window:
5.1.Use the window control button Close.
6. Minimise all windows:
6.1. User the window control button Minimize.
7. Close all windows:
7.1.Click on the open Documents window in the bottom panel;
7.2.Click the window control button Close;
7.3.Repeat these steps for the other windows.

Installing and Removing Software

Applications on the computer can be added or removed as needed. Software is added to
computer systems by installing it. The operating system is installed first, followed by
applications. Installation is a special process during which the software files are placed in
a specific sequence and locations, and the necessary changes are made in the operating

system.

This sequence is determined by the software developer and the characteristics of the
operating system. In many cases, software can be installed automatically and the
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process of copying the application files is not seen by the user. Some applications may
already be added to the operating system during its installation.

Some applications may require add-ons to the operating system. The installation process
usually determines them automatically.

The Linux system offers an online repository containing a large number of various
applications.

Note!

The administrator password is required for installing and removing software.
The computer system must be connected to the web, or software installation discs must
be available.

To install an application in the Linux Ubuntu Gnome environment:

1. Open the software management centre:
1.1. Perform the command Applications->Ubuntu Software Center;

2. In the search field of the Ubuntu Software Center dialogue box, enter the name of
the application or the task that it will have to perform;

3. Select the necessary application in the list;
Click More Info to view additional information:

@ - O Ubuntu Software Center

File Edit View Help

e Cetsofhwarg [ < ‘ 3 ] [ Gek Software Search Results ] Q, paint &
v I nstalled Software :
y . GIMP Image Editor
@ Provided by Ubuntu Create images and edit phetographs

i,

) History 'ﬁ Tux Paint
i
oo

A drawing program for children.

KolourPaint
Paint Program

install
| Krita
Edit and paint images

=
Z GNU Paint
A small-scale painting program for GNOME, the GNU Desktop

i]li mtPaint graphic editor
painting program to create pixel art and manipulate digital photos
¥ MyPaint
Paint images from scratch
44 PintaImage Editor
Create and edit images and photographs
. XPaint
- Xpaint painting application

rgbPaint

Very basic painting program

& Gnome Paint Drawing Editor
Create and Edit Drawings or Images =
Show 22 technical items

12 matching items

5. Click Install:
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# - 0 Ubuntu Software Center
File Edit View Help

2 Get Software [ 4 ‘ " ][Get Software > SearchResults > KolourPaint
v E Installed Software

@ Provided by Ubuntu
@ History KolourPaint

@0 Paint Program

‘ Free | Install |

KolourPaint is a simple drawing and image e e fme ]
editing application for KDE 4. It aims to be )
easy to use, providing a level of Functionality
targeted towards the average user. Itis ideal
For common tasks such as drawing simple
graphics and touching-up photos.

This package is part of the KDE 4 graphics
module.

Website

Total size:  1,235kB to download, 2,781kB when installed
Version:  4:4.5.1-Oubuntu3 (kolourpaint4) -

6. Enter the system administrator password;
7. Wait until the system notification that the installation has been completed:

KolourPaint

Paint Program

00@-

Installed | Remove

Find itinthe menu: Applications » _{ Graphics » . KolourPaint

To remove an application:

1. Open the software management centre;
Find the necessary application:
2.1.By entering the name of the application in the search field;
or
2.1.By selecting Installed Software:

3 m Get Software
|;| Installed Software

@ Provided by Ubuntu
@ History

2.2.Select the necessary application in the installed software pane:

3. Click Remove:

A KNetAttach
Network Folder Wizard ‘ ‘

"~ KolourPaint
"""/ Paint Program

ity

Language Support (language-selector)
Configure multiple and native language support on your system

4. Enter the administrator password.

Note!
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Although Ubuntu offers tens of thousands of free applications, it is also possible to
purchase commercial software.

Task 2. 6. Add a simple drawing application to the computer

1. |Install the application GNU Paint:
1.1.0pen the software management centre with the menu command
Applications->Ubuntu Software Center;
1.2.In the search field, enter the application name GNU Paint;
1.3.In the list of search results, click on GNU Paint;
1.4.Click Install;
1.5.Enter the system administrator password in the dialogue box and
click Authenticate;
1.6.After the installation is finished, close the software management centre
dialogue box by clicking the control button Close.
2. Open the application:
2.1.Perform the menu command Applications—>Graphics->GNU Paint;
3. Close the application:
3.1.In the application window, perform the menu command File->Quit.

Basic System Information

It is not possible to determine visually what kind of operating system the computer is
using. This especially applies to Linux operating systems, as Linux can have several
graphical work environments, for each of which dozens of themes can be selected and
customised. Many graphical environments may also have additional visual effects.

When planning the use of computer systems, reporting a problem to a help desk,
purchasing commercial software or simply asking someone “how to...”, it is important to
know the computer’s operating system, graphical environment and basic technical
parameters.

It is important to determine both the parameter itself and its version, which is indicated
by the numbers following the name; e.g., OpenOffice.org 2, OpenOffice.org 3.3.

To determine the basic information in the Linux Ubuntu Gnome graphical
environment:

1. Open the System monitor dialogue box with the menu command
System->Administration->System Monitor:
2. Find the necessary information in the System tab:
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-

% - O System Monitor
Monitor Edit View Help

System|| Processes | Resources | File Systems

dace-Ubuntu_Computer

Ubuntu 1
Release 10.10 (maverick) A
Kernel Linux 2.6.35-25-generic J
GNOME 2.32.0 B
Hardware
Memory: 1001.7 MiB C
Processor: AMD Athlon(tm) Dual Core Processor 4850e D

System Status
Available disk space: 2.7 GiB E

A —type and version of operating system ; B —graphical interface version; C — size of random-access
memory; D — processor model; E — available space on the computer’s hard drive

Image 7. Basic information of the system

Task 2. 7. Determine the computer’s basic information
1. Perform the menu command System->Administration—>System Monitor;
2. If necessary, open the System tab in the System Monitor dialogue box by left-

clicking on it;

3. Determine:
3.1.The type and version of the operating system;
3.2.The type and version of the graphical environment;
3.3.The size of the random-access memory;
3.4.The space available on the computer’s hard drive.

Print Management

For applications to be able to print documents and other materials, a printer is needed.
It must be connected to the computer directly or through a network, and the operating
system must be able to control the connected printing device.

An application prepares a document for printing; the data is processed by the operating
system and submitted to a printer managed by it. Print jobs are arranged in a queue in

the order of execution.

Useful tip:
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If the printer fails to print, it is recommended to avoid executing the print command
again. Check the print queue of the selected printer, and remove the job at the top of
the queue that cannot be executed.

For the operating system to be able to manage a printer — send print jobs to it — it is
necessary to install a special programme matching the model of the printer — a printer
driver.

Several printers can be added to the operating system, including virtual printers that do
not physically print, but create files in a specific format. Remote network and web
printers can also be connected to the computer.

One of the connected printers is set as the default. There is a checkmark of the default
printer’s icon.

Note!

Before adding a printer, read its user manual. Many printers have a specific sequence of
software installation and connection.

To add a printer to the computer:

Connect the printer to the computer with a cable;
. Open the printer configuration window: System->Administration—->Printing;
3. Click Add:
[ % — O Printing - localhost

Server Printer Group View Help

geAdd v @ Filter: | Q @
V= —
i— " T
Kyocera-Mita-KM-2550 Samsung-CLP-300

Connected to localhost
4. Selected the connected printer in the list:
Select Device

Devices Description

(C HPLIP software driving a printer, or the printer
Other function of a multi-function device.

> Network Printer

5. Click Forward;
Select the printer’s driver by the manufacturer:
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Choose Driver

@® Select printer from database
) Provide PPD file

) Search for a printer driver to download
The Foomatic printer database contains various manufacturer provided PostScript
Printer Description (PPD) files and also can generate PPD files for a large number of

(non PostScript) printers. But in general manufacturer provided PPD files provide
better access to the specific features of the printer.

Makes 5
Fujitsu

Genicom
Gestetner
Heidelberg
Hitachi

IBM
Imagen
Imagistics

7. Click Forward;

8. Select the printer’s model in the list;

9. Click Forward;

10. Enter Printer Name and Description, if necessary:

Describe Printer

Printer Name
Short name for this printer such as "laserjet"

[HP-Color-LaserJet

Description (optional)
Human-readable description such as "HP LaserJet with Duplexer”
|HP Color LaserJet

Location (optional)
Human-readable locationsuchas "Lab 1"

11. Click Apply.

To set a default primary printer;

1. Select the printer in the Printing dialogue box;

2. In the Printing dialogue box, perform the menu command Printer->Set As
Default.

To print from an application:

1. Perform the menu command File->Print in the application;
2. Inthe Print dialogue box:

2.1.Select a printer or use the default printer;

2.2.Specify the Print Range;

2.3.Specify the number of copies;

2.4.Click Print.

Note:

In some applications, the print dialogue box can have a different layout and design.
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A — print the entire document; B — print specific pages; C — print the selection; D — select the printer; E — set

the number of copies

& Print
Printer
Name Kyocera-Mita-KM-2550 -

Status Default printer
Type CUPS:Kyocera-Mita-KM-2550

Properties...

Location kuochera
Comment Kyocera Mita KM-2550
Print to File

Print range Copies

B —| Pages 1 : :
Jel?ectow ] mﬂi] mﬂi

Number of copies

Options... oK Cancel

Image 8. The Print dialogue box in OpenOffice.org Writer

1 =

& Collate

Help

The list of jobs submitted to the printer can be viewed and managed in the Printing

dialogue box.

To manage a print job:

1. Open the dialogue box Printing: System->Administration->Printing;
2. Select the printer;
3. Perform the menu command Printer->View Print Queue;
4. Select the print job;
5. Perform actions:
H

9 - Docpment Pript Sthtus Kyuw{era Mita-KM-2550)
A—@ Qg,r ¢ close

Job User Document Printer Size Time submitted Status

4 dace Untitled Document 1 Kyocera-Mita-KM-... 7k  aminute ago

&, Pending - Not connec...

3 dace Untitled1 Kyocera-Mita-KM-... 6k  aminute ago

Printer '"Kyocera-Mita-KM-2550" may not be connected.

U=l Processing - Not con...

A —refresh list; B — show completed jobs; C — cancel job; D — cancel selected jobs; E — pause job; F —resume

paused job; G — repeat selected jobs; H — save selected print jobs

Image 9. Management of print jobs

Task 2.7. Determine what printing devices are connected to the computer

1. Perform the menu command System->Administration->Printing;

2. Inthe Printing dialogue box, view the printers connected to the computer.

Computer File System
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Information on a computer is stored in the form of files. Files are works created in an
application and saved by the user. The operating system and applications also have
system files, which they use for their operation.

As the number of user files grows, it becomes useful to group them in folders, arrange
them in a specific order. Folders are used to arrange files on a computer. Folders and
files, in turn, are stored on the computer’s disk. Operating system files are also arranged
in a specific hierarchical structure.

Files and folders in the graphical environment of the operating system and applications
are represented by special images. Icons are also used to represent the computer’s file
storage devices, printers, scanners, and other devices.

The graphical image of the folder icon is usually easy to understand:

yijesr filsg

User Folders

Let’s look at an example of user file structure:

=3 home
=B carl
=[=|
E] Desktop
=[] Documents
=[] 2 _computer files
E] 2.10_extract
£ 2.2 text
"] 2.8 files
=7 2.9 move
E] folder_new
E7 folder old
=[] 4 _izklajlapas

In multi-user operating systems, which include Linux, each user already has their own
file storage structure in place. User folders are arranged in the Places menu:
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Places | System e;
4} Home Folder
@l Desktop

|l 000
|l (null)

‘Doc

x

L Music Open '/home/dace/Documents’
|l Pictures
i Videos

|i.j Downloads
B computer

|[[=] Network
=] ©00 on 10.0.0.60

Connect to Server...

Search for Files...

Recent Documents s

Note!

Although the user can work in any folder of the file structure by using the administrator
password, it is best to use the user folders already created by the operating system.

User folders created by the operating system:

e Home folder — the main folder of the user account.

e Desktop — this folder contains the icons, files and folders that are shown on the
desktop.

e Documents — applications save user documents (files) in this folder by default.

e Music —the folder for storage of audio files.

e Pictures — the folder for storage of picture files.

e Videos - the folder for storage of video files.

e Downloads — the folder for files downloaded from the web.

e Public folder accessible from the network — the information stored in this folder
is also available from other computers within the same network.

Further modifications and additions to this existing structure are up to the user.
The user can create new folders, place subfolders in them, and arrange files in a way
convenient for the user. Applications also allow saving files in any location on the
computer. The user can also add the available network resource folders.

File managers are used to browse folders. The default file manager in the Linux Ubuntu
Gnome graphical environment is Nautilus. The manager opens in a separate window.

To open the user’s home folder:




37 Module 2

Perform the menu command Places—>Home Folder:

r
x1=

File Edit View Go Bookmarks Help

=D Forward v 4 C 4 Q 100% @ | IconView v | Q ]_ B
Places v % < || fildace| | Public
‘il dace
@ Desktop m ] ‘7‘13
File Syst - - C
— Filesystem Desktop Documents Downloads
sl Network
& Trash . ‘,.1 i
il Documents = ‘-. -
Music Pictures Public

i Music
i@ Pictures

I8 videos [ ’ j hd

& Downloads Templates Videos Examples

What

Loreg D
N— lorem_ipsum

N\

Eo items, Free space: 2.8 GB E
N J

A

A —folders; B —toolbar; C —folder icon; D —file icon; E —amount of free space

Image 10. Home folder in file manager Nautilus

To open a folder:
Double left click on the folder icon

or
1. Select a folder in the file browser;
2. Perform the menu command File->Open.

Network and Remote Folders

Computers today are often connected on a network and to the web. In addition to the
traditional file storage on data storage devices, it is also possible to use web and
network resources. They can also be added to the user’s file system.

Using web resources allows accessing data from any computer with an Internet
connection. Placing files on websites does not necessarily make them available to
everyone. The user can set specific access permissions.

Units of Measurement

One of the main characteristics in computer systems is the data size. It is a property of
both files and data storage devices. Size is also important for e-mail inboxes, data
transfer and storage. A user who wishes to save data on a data storage device needs to
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have an understanding of the data size and storage capacity. There are also cases when

limitations of services prevent sending a file online or placing it on one’s web page.

The size of files, folders and disks is measured in bytes and derived larger units:

1 KB =1024 B; KB — kilobyte

1 MB =1024 KB; MB — megabyte
1 GB =1024 MB; GB — gigabyte
1TB =1024 GB; TB — terabyte

Approximate examples of file sizes:

One song in MP3 format — 4 MB;

Video clip — 45 MB;

Three-minute video on a website — 10 MB;
Text document on two pages — 30 KB;

Picture from a digital camera — 3 MB;
Installation file of a small application —12 MB.

Data Storage Devices

Typical data storage devices are:

Hard disk drive (HDD) — a device in the computer’s system unit. Stores the files
of the operating system, applications, and user-created files.

USB flash drive — a removable, compact memory storage device. Uses the
computer’s USB connection. Useful for storing and transporting information.
Compact Disc (CD) — an optical storage medium. Used to store and transport
information. May be recordable or rewritable depending on the type.

DVD — an optical storage medium, similar to a Compact Disc, but with a larger
capacity.

Memory cards — various types of small, removable data storage devices.

Remote disk — a data storage device located on a network computer and
available as a resource. Remote disks can be set to disallow modifying their
content.

Examples of storage capacities:

Compact Disc: 650- 720 MB, depending on the make;

DVD: 4.7 GB or 9.4 GB for double-layer discs;

Hard disk drive: various storage capacities. Hard drives smaller than 80 GB are
rarely used in modern computers;

Flash drives: various storage capacities, from several dozen KB to tens of GB.

Note!

When connecting and removing USB data storage devices and memory cards, a specific

order must be observed to avoid accidental data loss.

To open a file from a USB flash drive or memory card:

1.

Insert the data storage device in the corresponding USB port;
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2. Wait until an icon appears on the desktop:

5D
PENDRIVE

3. Open the data storage device by double-clicking on it.

To remove a USB flash drive or memory card:

1. Close all windows and applications that are using the connected data storage
device;

Right-click on the icon of the data storage device;

Execute the command Safely Remove Drive;

Wait until the icon disappears;

vk W

Remove the memory storage device.

Useful tip:

Create backup copies of important data on another data storage device or online!

Navigation

Several file browsers are available in Linux systems. The Gnome graphical environment
already has the file manager Nautilus installed by default.

Nautilus ensures easier navigation in the computer’s file system.

A B C D E F G H

r

x O Documgnks

File| Edit View |Go Bookmarks Help

&@Back v =PForward v P '@' ﬁ @, 100% @& | IconView v

Places - R 4 || fll dace || Documents| | files_different J
il dace K
@ Desktop i i i
— File System 2_computer_files 4 _izklajlapas 5 _datubazes
= Network
& Trash i i i
'] Documents B . "

. 6_prezentacijas files_different Zemene
il Music
[@ Pictures Ej = &
IH Videos — —
i Downloads albums.ods course_database. dati.odb
odb
= @ = |
— .
dati_final.odb del.odp doc.odt
[ —— ] e
L
files and folders. files and folders. files and folders. =
27 items, Free space: 2.8 GB

M

Image 11. Navigation

e Back —move to the previous viewed folder (A);




Using the Computer and Managing Files 40

Forward — move to the next folder, if it has already been viewed (B);
Open the parent folder — go from a subfolder to its parent folder (C);
Reload the current location — reload the content of the current folder D;
Go to user’s home folder — (E)

Browse all local and remote disks and folders accessible from this computer (F)
Zoom the folder window (G);

Change the view of the folder window (H);

File and folder search tool — (1);

Go to previous visited folder — (J);

Current location within the file system — (K)

Folder’s content — (L).

Selected folder — (M);

To change the folder view:

Click the view button (H in Image 11);

Select in the menu:

2.1.1con View, to display the content of the folder as icons;

2.2.List view, to display the content of the folder as a detailed list;

2.3.Compact view, to display the content of the folder as small icons.

Sorting Files and Folders

Files and folders can be sorted manually or in a specific order according to different

parameters:

By file or folder Name;

By Size;

By Type;

By Modification Date;

By Emblems assigned to files. Files and folders that haven’t been assigned an
emblem will be placed at the end.

The order in which they are arranged can be alphabetically (numerically) ascending or

descending. Folders are listed first. Files and folders with numerical names are placed

before alphabetical names.

To arrange files and folders in alphabetical order by last modification date:

1.
2.

Open a folder in the file browser;
Perform the menu command View—->Arrange Items—>By Modification Date:
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View Go Bookmarks Help

: Q 100% &
Reload Ctrl+R
v Main Toolbar
v Side Pane F9 : :
v Location Bar 0 ‘3 &
v Statusbar - u
Public Ten
Extra Pane F3

Reset View to Defaults

Sl ==l

Show Hidden Files Ctrl+H
Downloads

Arrange Iltems 4 Manually

By Name

Zoom In Cirles  BYySize

Zoom Out Ctri+ yT e

Normal Size e By Modification Date A
By Emblems

* |[cons Ctrl+1
List Ctrls2 Compact Layout
Compact Ctrls3 Reversed Order

Useful tip:

Files and folders can be sorted with right-click menu commands in an open folder.

To change the sort order:

Perform the menu command View->Arrange Items—>Reversed Order

To arrange files and folders in list view:

1. Open a folder in the file browser;
2. Choose List view;
3. Click on the header of the respective column;
4. Click on the header again to arrange in reversed order:
Name Size 2| Type Date Modified
> zemene 6 item?fnlder Mon 21 Feb 2011 10:56:11 PM EET
B my movie.avi 57.2 MB | AV video Thu 01 Jul 2010 12:57:57 PM EEST
H extract_me.rar 20.5 MB | RAR archive Tue 08 Jun 2010 08:15:59 PM EEST
n 04 Synesthesia.mp3 11.9 MB | MP3 audio Tue 23 Nov 2010 01:58:30 PM EET
ﬂ 1-07 Youth Explosion.mp3  10.8 MB MP3 audio Tue 23 Nov 2010 02:08:07 PM EET
ﬂ my_song.mp3 10.2 MB | MP3 audio Wed 03 Feb 2010 03:55:18 PM EET
8l for_web.flv 9.8 MB | Flashvideo Thu 29 Apr 2010 05:54:54 PM EEST
- | my_movie.MPG 2.1 MB  MPEG video Sat 09 Jun 2007 12:02:46 AM EEST
[ extract_me.zip 1.9 MB | Zip archive Mon 25 Oct 2010 10:23:21 AM EEST
@ run_me.exe 1.0 MB | DOS/Windows executable Mon 14 Feb 2011 11:26:48 PM EET
@ BENCH.DLL 56.0 KB DOS/Windows executable Wed 06 Aug 2003 09:01:20 PM EEST
@ Partyplanner1.xlsx 13.5 KB Microsoft Excel Worksheet Wed 28 Jul 2010 09:51:44 AM EEST

teksks.docx 12.5 KB Microsoft Word Document Tue 18 May 2010 12:42:48 PM EEST
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File Properties

Each file (folder) is characterised by a number of properties. Some of them can be
assigned by users themselves, others — by the operating system.

A file or folder is characterised by:
¢ Name;
e Location within the computer’s file system;
o Date created;
e Last Accessed date;
e Last Modified date;
e Emblems, categories assigned by the user;
e Association with an application — Open With;
e Permissions to perform actions with the file (folder);
e Other parameters particular to the file type.

To view the properties of a file (folder):

1. Right-click on the icon of the file, folder;
2. Choose Properties in the right-click menu:

® my_song.mp3 Properties

Basic | Emblems | Permissions | Open With | Notes | Audio

Name: [ ]
mp3 Type: MP3 audio (audio/mpeg)
Size: 10.2 MB (10672731 bytes)

Location: /home/dace/Documents/files_...
Volume:  unknown

Accessed: Sun 27 Feb 2011 07:01:26 PM EET
Modified: Wed 03 Feb 2010 03:55:18 PM EET

Help Close

To disallow modifying the content of a file or folder, or to safeguard against accidental
changes in an important document, it can be made read-only, making it impossible to
save changes in the file’s content.

To prohibit modifying a file, folder:

1. Open the Properties of the file, folder;
2. Open the Permissions tab;
3. Inthe Access menu, select the property Read Only:
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® my_song.mp3 Properties

Basic | Emblems | Permissions | OpenWith | Notes | Audio

Owner: dace-Dace

Access: Read-only v
N

Group: dace v

Access: Read-only v

Others

Access: Read-only v

Execute: Allow executing file as program

SELinux context: unknown
Last changed: Sun 27 Feb 2011 07:17:07 PM EET

Help Close

4. Close the Properties dialogue box by clicking Close.

To rename a file, folder:

1. Right-click on a file or folder;
2. Choose the Rename command;
3. Enter the new name, replacing the existing one;
4. Press the Enter key on the keyboard.
Note!

The filename extension must not be changed when renaming a file!
Choose a name that can be understood.

Although the operating system also supports letters of other languages, it
recommended to use only characters of the Latin alphabet in names.

Task 2.8. Perform the following actions in file browser Nautilus

1. Inthe file browser, open the subfolder 2.8 _files of the folder 2_computer_files:
1.1. Perform the command Places->Documents in the top menu;
1.2.Select the folder 2_computer_files by left-clicking;
1.3. Perform the command File->Open in file browser Nautilus;
1.4.Select the folder 2.8_files;
1.5.Press the Enter key on the keyboard.
2. Change the view to List View:
2.1.Click on the menu in file manager Nautilus;
2.2.Select List View:

Icon View

1% @& CompactView Q

3. Arrange files alphabetically, in ascending order, by file type:
3.1. Left-click the Type button at the top of a column.




Using the Computer and Managing Files 44

4. Arrange files alphabetically, in descending order, by file name:

4.1. Left-click the Name button at the top of a column twice.

v

Change the view Compact View:

5.1.Click on the menu in the Nautilus window;
5.2.Select Compact View.

o

Increase the size of icons:

6.1.Click the zoom button Increase the view size:

Q 150% @ | | compactView v | Q

Files || 2.8_fil _ﬁlncrease the view size

cal.ods X Partyplanner.xlsx
| =)

7. Dete

rmine the size of a file:

7.1.Right-click on the icon of the file synth.mp3;

7.2.1

n the right-click menu, choose Properties;

7.3.View the file’s Size.
8. Add an emblem to the file symphony.mp3:

8.1.0pen the file’s properties:

8.1.1.Left-click on the file symphony.mp3,

8.1.2.In the menu of the Nautilus window, perform the command

8.2.1

File->Properties.
n the Properties dialogue box, open the Emblems tab by clicking on it;

8.3.Tick the checkbox Favorite:

OK

&

Favorite

9. Protect a file against accidental deletion.

10. View
10.1.
10.2.

11. Chan
11.1.

the content of a file:
Double left click on the file lorem_ipsum.txt;
Close the application gedit.

ge the default application for opening a file:
Open the Properties of the file:

11.1.1. Left-click on the file lorem_ipsum.txt,

11.1.2. In the menu of the Nautilus window, perform the command

11.2.

11.3.

11.4.

File->Properties.
In the file Properties dialogue box, open the Open With tab by clicking
on it;
Select the application OpenOffice.org Word Processor in the list:

Basic | Emblems | Permissions | OpenWith | Notes

Select an application to open lorem_ipsum.txt
and other files of type "plain text document”

G)S?j OpenOffice.org Word Processor
# Text Editor

Close the dialogue box by clicking Close.
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12.

13.

14.

15.

16.

17.
18.

View the content of a file:

12.1. Double left click on the file lorem_ipsum.txt;

12.2. Close the application OpenOffice.org Writer.

Rename the folder lorem_ipsum.txt to lorem.pdf:

13.1. Right-click on the icon of the file lorem_ipsum.txt;
13.2. In the right-click menu, choose the command Rename;
13.3. Enter the file name lorem and extension pdf.

Try to open the file lorem.pdf by double left clicking, and see the error message:

Protect a text file against being modified:
15.1. Open the Properties of the file modify.txt:
15.1.1. Left-click on the file modify.txt,
15.1.2. In the menu of the Nautilus window, perform the command

File->Properties.
15.2. In the Properties dialogue box, open the Permissions tab by clicking on
it;
15.3. In the Access menu, select Read-Only:
Oowner: dace - Dace

Access: | Read-only v |

15.4. Close the Properties dialogue box by clicking Close.
15.5. Make sure that a padlock is shown on the file’s icon:

You €
L)
modify.txt
Test the result:
16.1. Open the file modify.txt by double left clicking;
16.2. Try editing the document’s text.
Close gedit;
Close Nautilus.

Actions with Files and Folders

Finding a File, Folder

Computers are capable of storing a massive amount of information. The built-in search

tools can be used to find the necessary information more quickly.

Useful tip:

The latest documents opened on the user account can be viewed by performing the

menu command Places—>Recent Documents:
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) || plain_text

|1 lorem_ipsum

|1 lorem_ipsum.rtf

| doc.rtf

|_] doc.odt

[ extract_me.zip

B my_movie.avi

& for_web.flv

8 1-07 Youth Explosion.mp3
smb: vadlinijas.doc

Clear Recent Documents...

To search for a file, folder by its name:

Perform the menu command Places—>Search For Files;
Enter the name or a part of the name in the Search For Files dialogue box;
Specify the folder in which to search, if necessary;

HwnNPe

Click Find in the dialogue box:
[ @ — o 9 Files Found - Search for Files

Name contains: |Ffiles -

Look in folder: |{lifdace v

> Select more options

Search results: 9 files Found
Name Folder
|l 2_computer_fi les dace/Documents
[ Ifiles_and_folders.jpg dace/Documents
[ files_and_folders.png dace/Documents
J| files_and_folders.swf dace/Documents
[ files_and_Ffolders.tif dace/Documents -
Help Close ITJ

To search for afile by its content:

Perform the menu command Places—>Search For Files;

Enter the name or a part of the name in the Search For Files dialogue box;
Specify the folder in which to search, if necessary;

Choose to Select more options;

In the field “Contains the text”, enter text that the file must contain :

F

# - O No Files Found - Search for Files

vk wnN e

Name contains: |files A

Look in folder: |flifdace v

¥ select more options

Contains the text: [folderi Remove

Available options: | Date modified less than v Add

6. Click Find in the dialogue box;
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Useful tip:

When searching for files by their name and
the search options:

content, wildcard characters can be used in

A question mark (?) substitutes any one character;

An asterisk (*) substitutes any number of characters.

For example, entering *.txt in the name field will search for all files with the

extension txt.

To search for afile, folder by its properties:

Enter the name or a part of the name in

Choose to Select more options;
Open the Available options menu:

vk wN e

Available options:
:archresults:
Size at least
Size at most

File is empty

Owned by user
Help
_ Owned by group

Owner is unrecognized

Name does not contain

Show hidden and backup files
Follow symbolic links

Exclude other filesystems

Name matches regular expression

Perform the menu command Places—>Search For Files;

the Search For Files dialogue box;

Specify the folder in which to search, if necessary;

Select properties, for example:

6.1. Date modified less than, Date modified more than;

6.2.Size at least, Size at most;

¥ select more options
Size atleast: |18

Size at most: | 212

Available options: | Conktains the texk

Add the properties to the search options by clicking Add;
Set the values of the properties; e.g., file size from 18 KB to 212 KB:

-

- | kilobytes | Remove |

- | kilobytes | Remove |

-

-
|

. Add |

Searchresults:

Name Folder

5 files Found

? files_and folders_final.odp dace/Documents/6 _prezentacijas/6.1_prez

[ files_and_folders.tif
JF| files_and_folders.swf

| Help |

dace/Documents
dace/Documents

L3

| Close | Find ]
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9. Click Find.

Creating a New Folder

Before the creation of a new folder, one must consider its purpose — for what needs it
will be created, and where it will be located on the computer. A chaotic folder structure
makes locating files more difficult.

To create a new folder:

Go to the location on the computer where the folder is to be created;
Right-click on an empty space;

Choose the command Create Folder;

Enter the name of the new folder;

vk wnN e

Press the Enter key.

Selecting Files, Folders

Selecting several files, folders is necessary if an action is to be performed on several files
or folders simultaneously.

To select adjacent files, folders:

1. Open a location in the computer’s file browser;

2. Click the left mouse button and, without releasing it, drag a box around files, folders:

ol wd 3 3

untitled folder zemene 1-07 Youth 04 Synesthesia.mp3
Explosion.mp3

BENCH.DLL

my_movie.avi

run_me.exe teksts.docx

3. Release the mouse button.

To select non-adjacent files, folders:

1. Open a location in the computer’s file browser:
2. Pressthe Ctrl key;
3. Without releasing the Ctrl key, click on the files, folders to be selected:
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i -

L2

untitled folder zemene
e
BENCH.DLL extract_me.rar
¥
my_movie.vi my_movie.MPG Partyplanner1.xlsx
4 w,
run_me.exe teksts.docx

Copying Files, Folders

Copying is a universal method of transferring files, folders to another data storage
device and from external storage devices to the computer. Copying a folder also copies
all of its content.

To copy files, folders:

Open the location of the files, folders;
Select the necessary files, folders;
Perform the menu command Edit->Copy;
Open the target location;

Perform the menu command Edit->Paste.

vk wN e

Moving Files, Folders

Moving is an action similar to copying; only the selected items are not preserved in their
original location. A universal method is using the menu command Cut.

To move files, folders:

Open the location of the files, folders;
Select the necessary files, folders;
Perform the menu command Edit->Cut;
Open the target location;

vk Wi e

Perform the menu command Edit->Paste.

Deleting and Restoring Files, Folders

Upon deleting a file or folder, it is not immediately deleted permanently; it is first placed
in a special folder called Trash. It is possible to restore deleted items from this folder.
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To delete files, folders:

1. Open the location of the files, folders;
2. Select the necessary files, folders;
3. Perform the menu command Edit->Move to Trash.

To restore deleted items:

1. Open the file manager;
2. Inthe Places pane, select Trash:

Places - R . Trash
it dace Trash
@ Desktop

1 File System

=l Network i

ﬁwnled folder
il Documents

[l Music BJ

[ Pictures -

i courses.xls
I videos
i Downloads

3. Select the necessary files, folders;
4. Perform the menu command Edit->Restore.

The space taken by Trash on the computer’s hard drive can significantly grow with time.
Although modern operating systems can automatically delete the oldest items when the

space used by Trash exceeds a set limit, it can also be done manually by the user to free
up space on the hard drive.

To empty the Trash:

1. Open the file manager;

2. InPlaces pane, right-click on the Trash;

3. Perform the menu command Empty Trash:
 S—-

Open ¢

BDo  openinNewTab

@MU 6oenin New Window |
=) Pic!

@ vid !
i Do

& Tra—>

Note!

Emptying the Trash irreversibly deletes all the items in it!

Task 2.9. Manage files

1. Copy files to a new folder:
1.1.In the file browser, open the folder Documents:
1.1.1.Perform the command Places->Documents.
2. Create a new folder called test:
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2.1.Perform the menu command File->Create Folder in the window of the
Documents folder:

2.2.Enter the folder name: test;

2.3.Press Enter on the keyboard.

In the file browser, open the 2.9_move subfolder of the 2.9_move folder:

3.1.Perform the top panel menu command Places—>Search for Files;

3.2.In the Name contains field, enter a part of the folder name: move;

3.3.Click Find in the dialogue box;

3.4.Double left click on a search result:

r

% — O 2Files Found - Search for Files
Name contains: |[move v
Look in folder: |{lfdace v

b Select more options

Search results: 2 Files Found
Name Folder Size | Type Date Mod
= | 4.0K8 Folder

|l 2-9_move lgacefDesI~:top,r’:z_c:-ornp|.|ter_l=iles 4.0KB folder Monday, F

Help Close |  Find

3.5.Close the search window by clicking Close.
Copy the files logical.ods, lorem_ipsum.odp, files_and_folders.swf to the new
folder test:
4.1.Switch to the window of the folder 2.9_move, if necessary;
4.2.Click on the icon of the file logical.ods;
4.3.Press Ctrl on the keyboard;
4.4.While holding Ctrl, click of the files lorem_ipsum.odp, files_and_folders.swf;
4.5.Perform the menu command Edit->Copy;
4.6.Switch to the window of the Documents folder:
4.6.1.Click the button of the Documents folder in the bottom panel:

I Documents | pLINEE [2.9_move]

4.7.Select the newly created folder test with a left click;
4.8.Press Open on the keyboard;
4.9.Perform the menu command Edit->Paste.
Move the file my_song.mp3 to user folder Music:
5.1.Switch to the folder 2.9_move by clicking the corresponding button in the
bottom panel of the desktop;
5.2.Right-click on the icon of the file my_song.mp3;
5.3.In the right-click menu, choose the Cut command;
5.4.Go to the Music folder:
5.4.1.Click on the folder name Music in the Places pane;
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i Documents

e

5.5.Right-click on the folder content pane;
5.6.In the right-click menu, select the Paste command.
6. Move the folders folder_new and folder_old to Trash:
6.1.Go to the folder 2.9_move;
6.1.1.In the window of the Music folder, click Back three times to return to the

folder 2.9_move:

o

&Back| v =Hrorward + C 4 W Q 100% & |icon

1y
Go to the previous visited location RPN, fi[e
) R P

6.2.Select both folders at the same time:
6.2.1.Left-click above the folder folder_new;
6.2.2.Without releasing the mouse button, drag to create a box around both

-:=_[}

Places

folders:

6.2.3.Release the mouse button.
6.3.Press the Delete key on the keyboard.

Note!

By default, the file manager Nautilus does not ask for additional confirmation when
deleting an item. A deleted item can be restored from Trash.

7. Restore the folder folder_new:
7.1.0pen the Trash:
7.1.1.Perform a double left click on the Trash icon in the bottom panel of the
desktop:

—

¥
LS

7.2.Select the folder folder_new;
7.3.Perform the menu command Edit->Restore.
8. Empty the Trash:
8.1.Perform the menu command File->Empty Trash;
8.2.Close the Trash window by clicking the Close button in the title bar.
9. Move the folder folder_new to the Desktop.
9.1.Switch to the window of the folder 2.9_move by clicking the corresponding
button in the bottom panel;
9.2.If necessary, move the window so that the desktop is visible :
9.2.1.Drag the window by its title bar;
9.2.2.Resize by clicking on an edge and dragging.
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9.3.Click on the folder folder_new;
9.4.While holding the mouse button, drag it to the desktop;
9.5.Release the mouse button.
10. Close all open windows with the Close button.
11. Create a dialogue box icon (shortcut) to the folder 2_computer_files:
11.1. Open the Documents folder with the menu
command Places->Documents;

11.2. Click on the folder 2_computer_files with the middle mouse button or
scroll wheel;
11.3. While holding the middle mouse button (scroll wheel), drag the folder
icon to the desktop;
11.4. Release the mouse button;
11.5. In the menu, choose the command Link Here:
Move Here
gopy Here
Cancel -

12. Close the window of the Documents folder by clicking the Close button in the title
bar;
13. Double left click on the icon:

14. Close the window of the folder 2_computer_files by clicking the Close button.

Note:

Within the graphical environment of one operating system or application, the same
result can be achieved with different actions.

Other Actions with Files

File Compression
File compression is used to reduce the file size of large files.
Another purpose of compression is to combine several files into one.

It is particularly important when attaching files to e-mail messages, placing them on
websites, storing files on disks with limited capacity.

When looking at, for example, a printed sheet, it can be seen that a lot of the area is
white space not covered with ink. By using a special method, text in the document could
be compressed closely together and then decompressed later, obtaining an identical
document in the end.
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It is easy to tell the compression method of a file by its extension, e.g.:

o .zZip
e tar
o .gzip
e tar
L] .rar

Special software is required for file compression and extraction. In some operating
systems, this feature may be integrated in the graphical user environment by default.

To create a compressed file:

Open a location in the file browser;

Select an item (files, folders);

Perform the menu command Edit->Compress in the file browser;

In the Compress dialogue box, specify a name for the compressed file;

vk wnN e

Select the compression method in the menu:

#® - Compress

Filename: |
tar.gz

Location: " Documents v

Help Cancel | (SnCreakesy

E—"
6. If necessary, change the location of the compressed folder;
7. Click Create.

b Other Options

To extract a compressed file

1. Open the location in the file browser;
2. Select the compressed file;
3. Perform the menu command Edit->Extract Here;

The content of the compressed file will be extracted in a new folder with the name of
the compressed file.

Useful tip:

Compression and extraction commands can also be performed from the right-click
menu.

Task 2.10. Extract a compressed file, create a compressed file

1. Inthe file browser, open the subfolder 2.10_extract of the folder 2_computer_files:
1.1.Use the icon on the desktop created in the previous task — perform a double left
click onit;
or
1.1. Perform the menu command Places->Documents;
1.2.Double left click on the icon of the folder 2_computer_files;
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1.3. Double left click on the icon of the folder 2.10_extract;
2. Extract the compressed file extract_me.tar.gz in a new folder:
2.1.Right-click on the file extract_me.tar.gz;
2.2.In the right-click menu, perform the command Extract Here;
2.3.0pen the folder extract_me by double left clicking.
3. Compress all files in the folder 2.10_extract with the zip method:
3.1.In the navigation bar of the extract_me folder, click the button 2.10_extract;

4 || il dace | @ Desktop || Link to 2_computer_files | 2.10_extract | extract_me

3.2.Select all files and folders with the menu command Edit->Select All;
3.3.Perform the menu command Edit->Compress;
3.4.In the Compress dialogue box, select the compression method .zip;
3.5.Set the desktop as the location of the compressed file:

3.5.1.In the Location menu, choose Desktop;
3.6.Click Create in the dialogue box:

% - Compress

Filename: |2.10_exkract .Zip v
i

Location: |@@Desktop v

P Other Options

Help Cancel Create

N

4. Close the window of the folder 2.10_extract;
5. Make sure that there is an icon of the compressed file 2.10_extract.zip on the
desktop.

Protecting Files against Viruses

A computer virus is a small piece of software or an executable file developed for
malicious purposes and operating without the user’s knowledge.

Computer viruses may damage files, slow down or freeze the operating system, obtain
confidential information on the user’s computer and forward it to the author of the

virus.

Viruses may spread through removable data storage devices, e-mail messages.
Computers today are often linked on computer networks and connected to the web.
By using vulnerabilities in operating systems, they can spread rapidly. Websites may also
be infected and have hidden executable files.

Examples of computer viruses:
e Logic Bombs — viruses that are set off at a specific time or by a remote
command.
e Trojans — with a name derived from the Greek myth, theses viruses open a
backdoor not authorised by the user in the computer’s protection system.
e Worms — they spread on computer networks by using vulnerabilities in the
protection of operating systems.
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e Macro Viruses — macro viruses infect the files of specific applications. Macro
commands are small programmes operating in the computer to automate an
action. Macro commands are often used in word processors, spreadsheets,
database systems.

The largest number of viruses is developed for the environment and files of the
Windows operating system.

Protecting a computer against viruses requires:
e Observing caution when working with removable data storage devices;
e Avoiding attachments in suspicious e-mail messages;
e Avoiding unsafe websites;
¢ Installing antivirus software on the computer;
e Regularly updating the database of the antivirus software ;
e Regularly creating backup copies of data and storing them elsewhere, e.g., on a
remote disk or removable data storage device.

A popular antivirus in the Linux environment is ClamAV. It consists of the main
programme (clamav- daemon) and many additional modules and extensions.

Note!

The default installation of Linux Ubuntu does not include an antivirus.

To add an antivirus to file manager Nautilus:

Install the extension Antivirus scanning for Nautilus.

To scan a file or folder in file manager Nautilus:

In the file manager, open the location of the file (folder);
Right-click on the file (folder);
3. Inthe menu, perform the command Scan for viruses:
#® File Manager

Scanning 18 File(s)...

_E g:innmg file "/media/PENDRIVE/...final/project_budget final.ods"...

File 1 of 18

Found no infected file

-

» Details

About Close

Wait until the scanning is completed;
5. Close the dialogue box by clicking Close.

Using the Built-in Support Systems

An operating system offers many built-in help features. Help files are a kind of
user manual.
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Operating System’s Help Function

To use the help function of Linux Ubuntu:

1. Perform the menu command System->Help and Support:

9 0

Ubuntu Help Center

File Edit Go Bookmarks Help

@ Search:

Topics
New to Ubuntu?

Adding, Removing
and Updating
Applications

Files, Folders and
Documents

Customizing Your
Computer

Internet and
Networks

Welcome to the Ubuntu Help Center
To find help, insert a keyword in the search bar
Common Questions

Connecting to the internet

Enabling visual effects

Playing music

Importing photos

Keeping your computer updated

Can't find the answer?

The Ubuntu community provides extensive free
support

Canonical, its partners and approved companies

I T I

Music. Video and

2. Open the necessary topic by clicking on it
or
3. Enter the topic in the Search field.

Useful tip:

A help topic can be saved in the Bookmarks to make finding it again easier.

Help Feature in Applications

Applications also have built-in help functions.

To open the help system of an application:

In the application window, perform the menu command Help->Contents.

To open the help system in a dialogue box:

Click Help:

| ©OK | cancel Reset

Taking a Screenshot

A user may often need to ask for help to someone else. In this case, the user must be
able to determine the problem as accurately as possible and specify the application in
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question. It is even better if the problem can be shown visually. This can be done by
taking a screenshot.

To create a screenshot:

1. Press Print Screen in the top row of the keyboard:

2. Inthe Save screenshot dialogue box:
2.1.In the Name field, enter a name for the screenshot file ;
2.2.Choose the save location: Save in folder;
2.3.Click Save;
or
2.1.Click the button Copy to Clipboard;
2.2.0pen a suitable programme — an application of the OpenOffice.org suite or
image editing software;
2.3.In the application window, perform the menu command Edit->Paste.

Forcing an Application to Quit

There are sometimes cases when an open application does not respond to user input.
This often occurs when using unfinished applications, software test versions.
The computer can be restarted in order to quit such a programme, but it is not always
an acceptable solution. Another way is to use a special applet. Applets are convenient to
place in the top panel of the desktop.

To add an applet to the panel:

Right-click on an empty space in the panel;

In the right-click menu, choose the command Add to Panel;

In the Add to Panel dialogue box, click on the Force Quit applet in the list;
Click Add:

' & Addto Panel

P wnNe

Find anitem to add to the panel:

-, Fish
'f.,,:'l Display a swimming fish or another animated creature

Force Quit
., Force a misbehaving application to quit

Indicator Applet
Anindicator of something that needs your attention on the desktop

ﬁ Indicator Applet Session

Help | [ Add J. Close

5. Close the dialogue box by clicking Close.

To close an application window:
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1. Click the Force Quit button in the top panel:

Force a misbehaving application to quit

Position the mouse pointer in the shape of a cross over the application window;
Perform a left click;
4. Inthe Force Quit dialogue box, click Force quit:

% Force Quit

0 Force this application to exit?

If you choose to Force an application to exit,
unsaved changes in any open documents in it might
get lost.

Cancel Force quit

Useful tip:

To stop the Force Quit applet, press Esc on the keyboard.

Task 2.11. Paste a screenshot in a text document

1. Press Print Screen on the keyboard;
1.1.In the dialogue box, click Copy to Clipboard;
2. Open the text file screenshot.odt:
2.1.Perform the command Places—->Documents;
2.2.0pen the folder 2_computer_files by double left clicking;
2.3.0pen the folder 2.11_screenshot by double left clicking;
2.4.0pen the file screenshot.odt by double left clicking;
2.5.Press Ctrl on the keyboard;
2.6. While holding Ctrl, press the V key.
2.7.Save the changes in the document by clicking the Save button in the toolbar;
2.8.Close the window of OpenOffice.org Writer by clicking the Close button in the
title bar.

Task 2.12. Test your knowledge by completing tasks

Notes:
The test includes 24 tasks, each of which is evaluated with points.
The test must be completed in 45 minutes.

Although the tasks include instructions, it is also permitted to use other methods that
seem faster and more convenient to the user.

Try to complete the tasks on your own, without reading the instructions.

The test is finished successfully if more than 24 points are obtained (75% of the
maximum possible 32).

1. Open the text document file answers.odt, located in the folder
.../Documents/2_computer_files/2.12_test:
1.1. Perform the command Places->Documents in the top panel menu;
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1.2. Left-click on the folder 2_computer_files;
1.3. Press Enter on the keyboard;
1.4. Left-click on the folder 2.12_test;
1.5. Press Enter on the keyboard;
1.6.Click on the icon of the file answers.odt;
1.7.Press Enter on the keyboard.
2. Enter your name in the first row of the table:
2.1. Left-click on the second cell of the table;
2.2.Enter your name.
3. Which of these is a picture file? Enter the letter in the table opposite to the
guestion’s number:
A. filename.png
B. filename.odt
C. filename.mp3
D. filename.zip
4. Continue answering the questions. Which answer best describes the file structure in
an operating system:
¥ i} Home Folder

» @ Desktop J h

v
il Documents final answers.odt
¥ | 2_computer_files

> 2.2_Etext

b |l 2.8_files
bl 2.9_move

> |l 2.10_extract

* |l Final !

The file (folder) structure is sequential;

A
B. The files are arranged in an arbitrary order;
C. The files and folders are arranged in a hierarchical structure;
D. There is no specific structure of files and folders.
5. What is shown in this screenshot:

@ - O answers.odt - OpenOFffice.org Writer

Status bar of an application window;
Title bar of an application window;

0 ® >

Scroll bar;
D. Document menu.
6. Which of these is an icon of a file created in an application:

A. B. C. D.
—,
% —
gedit Samsung-CLP-300

7. What usually happens when a file is compressed?
A. The file size slightly increases;
B. The file size decreases;
C. The content of the file is encrypted;
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10.

11.

12.

13.

D. The file is moved to Trash.
What are the benefits of storing data in an online repository:
A. ltis possible to store text document files online;
B. Data stored online are available to anyone with an Internet connection;
C. The data can be safely shared with users specified by the data owner
through an Internet connection;
D. Only the user has access to the online data.
What is the purpose of creating backups on a removable data storage device:
A. It frees up space on the computer’s hard drive;
B. Itis easier to find the data on a separate storage device;
C. It makes it possible to restore the data in case of a system failure;
D. It makes the data easier to send to another user.
Which of these statements about computer viruses is true?
A. Compressed files cannot be infected with viruses;
B. Viruses infect only text and picture files;
C. Antivirus software requires regular updates;
D. Viruses do not spread through electronic mail.
Determine the size of your computer’s random-access memory (RAM). Enter the
number in the table, opposite to the question’s number:

11.1. Perform the menu command System->Administration->System
Monitor in the top panel;
11.2. Open the System tab in the System Monitor dialogue box, if necessary:
11.2.1. Left-click on the name of the tab:
% — O System Monitor

Monitor Edit View Help
Systﬂw Processes|| Resources | File Systems

11.3. Find the amount of Memory under Hardware:

Hardware
Memory: (1001.7 MiB
Processor: AMD Athlon(tm) Dual Core Processor 4850e

11.4. Enter the number in the table in the cell corresponding to the question’s
number:
11.4.1. Left-click on the cell;
11.4.2. Enter the answer.
Which of these filenames would be best in following good practice of file naming?
The document is a client service report for the 4™ quarter:
A. Untitledl.odt
B. Clients.odt
C. Q4_clients_report.odt
D. Report 4.odt
Which of these actions makes the computer system faster?
A. Setting up a password for the user account;
B. Disabling the firewall;
C. Installing a larger hard drive;
D. Installing additional random-access memory (RAM).
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14. Open the files subfolder of the folder 2.12_test in the file manager. Set the folder
view to show the file name, size, type and last modified date:
14.1. Minimise the window of the answers document:
14.1.1. Click the Minimize button in the title bar of the document:

# - o answers.odt
File "Edit View Ins¢

14.2. In the window of the folder 2.12_test, double left click on the folder
files;

Useful tip:

If the folder was closed, open it as specified in task 1.

14.3. In the file manager menu, choose List View:

4 W @ s50% ® ListView N Q

15. Set the file list to show the largest files at the beginning:
15.1. Left-click the Size button twice in the column header:
Size =&
0 items
Oitems

2.1 MB
16. Select the files my_movie.MPG and extract.zip. Take a screenshot of the folder in
the file manager and paste it in the second page of the answers document:

16.1. Left-click on the file my_movie.MPG;
16.2. Press Ctrl on the keyboard;
16.3. While holding Ctrl, click on the file extract.zip:
Name Size = | Type Date Modifies
> folder_old Oitems Ffolder Mon 28 Feb 2(
> folder_new Oitems Folder Mon 28 Feb 2C
E] my_movie.MPG 2.1 MB MPEG video Sat 09 Jun 200
[l extract_me.zip 1.9 MB | Zip archive Mon 25 Ock 2C
h -| esv_eksports.odb 45.1 KB ODB database Sun 13 Feb 20°
J#| files_and_folders.swf 43.9 KB Shockwave Flash file Tue 21 Dec 20
h | parskats.odb 43.6 KB ODB database sun 13 Feb 20
~ files_and_folders.png 243 KB PNG image Tue 21 Dec 20

Mon 28 Feb 2(

18.1 KB

&9 extract.zip Zip archive

~Ifiles and folders.ipg 17.2 KB | JPEG image Tue 21 Dec 20
16.4. Release the Ctrl key;
16.5. Press Alt in the left side of the keyboard;
16.6. While holding Alt, press PrintScreen on the keyboard;
16.7. Release both keys;
16.8. In the dialogue box, click the button Copy to clipboard:
16.9. Open the document answers.odt:

16.9.1. Click on the window’s button in the bottom panel of the desktop:
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%] answe k answers.odt - OpenOffice.org Writer
16.10. Click in the beginning of the document’s second page after the text
Question 16;
16.11. Perform the menu command Edit-Paste in the document window;
16.12. Save the changes in the document:
16.12.1. Click the Save button in the toolbar.
17. Find on your user account all files of the application OpenOffice.org Writer with the

extension .odt. Enter the total number of files in the corresponding cell of the
answer table:

17.1. Perform the top panel menu command Places->Search for Files;

17.2. In the Name contains field of the Search for Files dialogue box, enter
the filename extension .odt

17.3. Click Find in the dialogue box;

17.4. Remember the number of search results (it may differ from the image):

® — O 35 Files Found - Search for Files

Name contains: |.odt v
Look in folder: |{liidace v
b Select more options
Searchresults: 35 files Found
Name Folder
|=| merge.odt dace/Desktop
|=| test.odt dacef/Desktop
|=| ttt.odt dace/Desktop
|=| screenshot.odt dace/Desktop/2_computer_files/2.11_screens
|=| screenshot_final.odt dace/Desktop/2_computer_files/2.11_screens
|=| Elton0.odt dace/Documents
|| Mr.0.odt dace/Documents -
Help Close | Find |
17.5. Close the window by clicking Close;
17.6. Left-click on the cell corresponding to the question’s number;
17.7. Enter the result;
17.8. Save the changes in the document with the answers:

17.8.1. Click the Save button in the document’s toolbar:

] @ Q E
TableCo

17.9. Close the document:
17.9.1. Click the Close button in the title bar;

18. Create the displayed folder structure in the folder 2.12_test:
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d

collection

N\
e e

movies music
mp3
18.1. Perform the command Places—>Documents;
18.2. Open the folder 2_computer_files with a double left click;
18.3. Open the folder 2.11_screenshot with a double left click;
18.4. Open the folder collection with a double left click;
18.5. Right-click in the folder window;
18.6. In the right-click menu, perform the command Create Folder:
Create Document ¢
18.7. Immediately, without performing any other actions, enter the folder
name movies;
18.8. Press Enter on the keyboard;
18.9. In the window of the collection folder, perform the menu
command File->Create Folder;
18.10. Enter the folder name music;
18.11. Press Enter on the keyboard;
18.12. Press Enter again;
18.13. Right-click in the window of the folder;
18.14. In the right-click menu, perform the command Create Folder:
18.15. Enter the folder name mp3;
18.16. Press Enter on the keyboard. Do not close the window of the music
folder;
19. Copy the files flash.swf and movie.mpg to the movies folder:
19.1. Open the folder 2.12_test:

19.1.1. Click the button 2.12_test in the navigation bar of the file manager:
4 || it dace || Documents || 2_computer_Ffiles 2.12_tSt final | | music
19.2. Select the files flash.swf and movie.mpg:

19.2.1. Left-click in the bottom right corner of the folder window;
19.2.2. While holding the button, drag to select both files:
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fFiles final
5 Y
A
19.2.3. Release the mouse button.
19.3. Perform the menu command Edit->Copy in the folder window;
19.4. Open the folder collection with a double left click;
19.5. Right-click on the folder movies;
19.6. In the right-click menu, perform the command Paste Into Folder.

20.

21.

22.

23.

Move the file song.mp3 to the folder mp3:
20.1. Open the folder 2.12_test:
20.1.1. Click the button 2.12_test in the navigation bar of the file manager.

20.2. Right-click on the file song.mp3;

20.3. In the right-click menu, perform the command Cut;

20.4. Open the folder collection with a double left click;

20.5. Open the folder music with a double left click;

20.6. Open the folder mp3 with a double left click;

20.7. Perform the menu command Edit->Paste in the folder window.

Rename the text file wrongname.odt to delivery.odt:

21.1. Right-click on the icon of the file wrongname.odt;
21.2. In the right-click menu, perform the command Rename;
21.3. Enter the new file name delivery without changing the

filename extension:

h

| odt |

21.4. Press Enter on the keyboard.

Delete the folder folder_to_delete and the file file_to_delete.xlsx;

22.1. Right-click on the folder folder_to_delete;

22.2. In the right-click menu, perform the command Move to Trash;

22.3. Left-click on the file file_to_delete.xlsx;

22.4. Press Delete on the keyboard.

Change the properties of the file attribute.txt to make it read-only:

23.1. Right-click on the file attribute.txt;

23.2. In the right-click menu, perform the command Properties;

23.3. In the Properties dialogue box, open the Permissions tab by clicking
on it;

23.4. In the Owner Access menu, select Read- only:

Basic | Emblems | Permissions | Open With | Notes

owner: dace-Dace

Access: Read-only v

N

23.5. Close the Properties window by clicking Close.
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24. Open the print dialogue box of the document answers.odt:

24.1.

Open the document answers.odt:

24.1.1. Perform a double left click on the icon of the file answers.odt.

24.2.
24.3.

Perform the menu command File-Print in the document window;
Print the document, if possible:

24.3.1. In the Print dialogue box, click OK.

In this module you learned how to:

Correctly start and shut down the computer system;
Change workspace settings;

Recognise various file types;

Understand the file structure of a computer;

Print documents;

Change the location of files and folders;

Compress files;

Use the built-in help functions.



Supplement 1
The correct answers of task 2.1.

1,3



Supplement 2

ECDL requirements for Module 2 — Using the Computer and Managing Files:

Use the main features of the operating system including adjusting the main
computer settings and using built-in help features;

e Operate effectively around the computer desktop and work effectively in a

e graphical user environment;

¢ Know about the main concepts of file management and be able to efficiently
o organize files and folders so that they are easy to identify and find;

e Use utility software to compress and extract large files and use anti-virus

e software to protect against computer viruses;

e Demonstrate the ability to use simple text editing and print tools available

e within the operating system.

Category Skill set Ref. Task item Page
2.1 Operating 2.1.1 First Steps 2.1.1.1 Start the computer and log on securely 5,6
System using a user name and password.

2.1.1.2 Restart the computer using an appropriate 14
routine.
2.1.1.3 Shut down a non-responding application. 58
2.1.1.4 Shut down the computer using an appropriate 14
routine.
2.1.15 Use available Help functions. 57
2.1.2 Setup 2.1.2.1 View the computer’s basic system 30
information: operating system name
and version number, installed RAM (random-
access memory).
2.1.2.2 Change the computer’s desktop 16
configuration: date & time, volume
settings, desktop display options
(colour settings, desktop background, screen
pixel resolution, screen saver options).
2.1.2.3 Set, add keyboard language. 20
2.1.2.4 Install, uninstall a software application. 28
2.1.2.5 Use keyboard print screen facility to capture a 58
full screen, active window.
2.1.3 Working with 2.1.3.1 Identify common icons like those 35
Icons representing: files, folders, applications,
printers, drives, recycle
bin/wastebasket/trash.
2.1.3.2 Select and move icons. 52,51
2.1.33 Create, remove a desktop shortcut icon, make 53
an alias.
2.1.3.4 Use an icon to open a file, folder, application. 37
2.1.4 Using Windows | 2.1.4.1 Identify the different parts of a window: 9
title bar, menu bar, toolbar or ribbon, status
bar, scroll bar.
2.1.4.2 Collapse, expand, restore, resize, 26, 26
move, close a window.
2.1.4.3 Switch between open windows. 26
2.2 File Management | 2.2.1 Main Concepts 2.2.1.1 Understand how an operating system 35
organizes drives, folders, files in a hierarchical
structure.
2.2.1.2 Know devices used by an operating 38
system to store files and folders like:
hard disk, network drives, USB flash drive, CD-
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Category Skill set Ref. Task item Page

RW, DVD-RW.

2.2.13 Know how files, folders are measured: 38
KB, MB, GB.

2.2.1.4 Understand the purpose of regularly backing 39
up data to a removable storage device for off-
site storage.

2.2.15 Understand the benefits of online file storage: 37
convenient access, ability to share files.

2.2.2 Files and 2221 Open a window to display folder name, size, 42

Folders location on a drive.

2.2.2.2 Expand, collapse views of drives, folders. 40
2.2.23 Navigate to a folder, file on a drive. 42
2224 Create a folder and a further subfolder. 48

2.2.3 Working with 2231 Identify common file types: word 10

Files processing files, spreadsheet files,
database files, presentation files, portable
document format files, image files, audio files,
video files, compressed files, temporary files,
executable files.

2232 Open a text editing application. Enter text into 13
a file, name and save the file to a location on a
drive.

2.2.33 Change file status: read-only/locked, read- 42
write.

2.2.3.4 Sort files in ascending, descending order by 40
name, size, type, date modified.

2235 Recognize good practice in folder, file 43
naming: use meaningful names for folders and
files to help with recall and organization.

2.2.3.6 Rename files, folders. 43

2.2.4 Copy, Move 2241 Select a file, folder individually or as a group of 48
adjacent, non-adjacent files, folders.

2242 Copy files, folders between folders and 49
between drives.

2.2.4.3 Move files, folders between folders and 49
between drives.

2.2.5 Delete, Restore 2.2.5.1 Delete files, folders to the recycle 50
bin/wastebasket/trash.

2.2.5.2 Restore files, folders from the recycle 50
bin/wastebasket/trash.
2.2.53 Empty the recycle bin/wastebasket/trash. 50

2.2.6 Searching 2.2.6.1 Use the Find tool to locate a file, folder. 45

2.2.6.2 Search for files by all or part of file name, by 46
content.

2.2.6.3 Search for files by date modified, by date 47
created, by size.

2.2.6.4 Search for files by using wildcards: file type, 47
first letter of file name.

2.2.6.5 View list of recently used files. 45

2.3 Utilities 2.3.1 File 2.3.1.1 Understand what file compression means. 53
Compression

2.3.1.2 Compress files in a folder on a drive. 54

2.3.1.3 Extract compressed files from a location on a 54
drive.

2.3.2 Anti-Virus 2321 Understand what a virus is and the 55
ways a virus can be transmitted onto a
computer.

2.3.2.2 Use anti-virus software to scan specific drives, 56
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Category Skill set Ref. Task item Page
folders, files.
2.3.23 Understand why anti-virus software needs to 56
be updated regularly.
2.4 Print 2.4.1 Printer Options 24.1.1 Change the default printer from an installed 33
Management printer list.
2.4.1.2 Install a new printer on the computer. 32
2.4.2 Print 2421 Print a document from a text editing 33
application.
2422 View a print job’s progress in a queue using a 34
desktop print manager.
2.4.2.3 Pause, re-start, delete a print job using a 34

desktop print manager.




